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Transactor Coffee Break Tour

A short informal tutorial for Transactor using the installed Example Lab Co
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Welcome to the Coffee Break Tour

Use this  tour to get  familiar with using Transactor.  If  you  haven't  yet  installed  Transactor  see  Install
Transactor

For more details on the procedures described in the tutorials please refer to Basic Working Procedures
in Transactor Help.

DO  feel  free  to  experiment,  because  anything  you  do  here  won't  affect  your  main  'Live'  Transactor

system.

So get the coffee on and let's get started. Tour the Main Form

Do you prefer a printed tour?

If you prefer to print out this tutorial a printer-friendly version is available as follows:

· From the Windows Start menu, choose All Programs (program files) - Transactor v61 - Printable
Coffee Break Tour

If your computer is not able to open PDF files, you can get a free PDF Viewer from the internet.
One such viewer is available from www.foxitsoftware.com or www.adobe.com

· In the PDF viewer, from the File Menu, choose Print

1 Tour the Main Form

Let's start by taking a look at  Transactor's  Main Form using the example lab data called DentaLab LTD
with its set of fictitious Surgeons and sample jobs.
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Starting the example dental lab Transactor Main Form 

· From the Windows Start menu, choose  All Programs (or Program Files)-Transactor v61-Transactor
Example Co

 
You should now see the Main Form. It may help to maximise this window.

Notice the caption at the top for the example company we are using, DentaLab Limited.

Notice the Menu Bar at the top and the Tool Bar underneath the menu bar.  The Tool Bar has some
useful buttons which we'll try in a moment.

Notice the Function Bar at  the bottom and the status  bar below it.  The Status  Bar at  the  bottom
usually displays a short helpful message.

Using the Job Navigator tool

· Just below the main menu, in the Tool Bar, click the View Last Document icon
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You should see the last Job Document that was entered in the example DentaLab Limited system.

Notice the job details  are in a 'grayed  out'  text.  This  means  they  can't  be  accidentally  modified.
More on how to modify jobs later.

Try  the View First  Document’  button and have a look at  some of the other jobs.  If you hover  the
mouse over the tool icons you will get useful hints.. 

Trying some other Actions and Functions

· Hover the mouse over some of the other tool bar buttons to see what they do

· Try Clear Form. Then point the mouse into the Surgeon Account area, and double click to bring up the
Surgeon selector. This is the same as choosing Surgeon - Select from the Main Menu.
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Note: You may see some menu choices, or Icons are not available. For example, if you have started, or
are modifying a job on the form, the Clear Form icon will be unavailable. This is because Transactor
doesn't want you to accidentally clear the form. Instead you need to choose an Action for the current job
eg. Book it in, Out or Delete it. Read more about this in the next section.

Once you’ve finished experimenting, press F12 to clear the form, or click on 'Clear Form' on the toolbar. 

You'll now be back to a clear Main Form.

2 Understanding Actions

Actions are 'Start New Job', 'Book In', 'Book  Out'  etc. You'll quickly become familiar with these 'Actions'
since the whole system is based around them.

Actions are done by choosing them from the Menu, but they are also available from the Function Bar at
the bottom of the Main Form.

The Function Bar is a handy way to quickly see what Actions you can choose. Some may be disabled
(grayed out) because it isn’t valid for what you are doing.  For example if you have no job details showing
on the Main Form, 'Book Out'  just doesn't make sense!

Let's do some simple Actions now just to get a feel for it. 

The New Job Action

· From the Main menu, choose Action - New Job, or choose F3 New Job from the Function Bar.
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You will see that the top right of the Main Form shows the Doc No which is also the Job No. Notice
that the State box describes the job's status in full (New Job)., later on this could display 'Booked
In', 'Booked Out'  or 'Booked Out Charged'.

We'll cover New Jobs and Booking In later, for now we'll just practice aborting this new job, to go
back to a clear Main Form. A New Job has been started, Transactor won't let us simply click Clear
Form so we need to practice using the Delete Action.

· From the Main menu, choose Action - Delete

Transactor doesn't want users to do things like deleting jobs accidentally, so it asks you for
confirmation. 

· In the Confirm Action dialog, choose Delete Job

You'll now be back to a clear Main Form and we have demonstrated that after starting a job you can
Delete it rather than continuing. 

3 The Clear Form Action

Clear Form is frequently used. For example, if you have been using the Main Form to view a Job's details
then at some point you need to clear this Job from the form so that you can select a different Surgeon or
Job/Document.

The Clear Form is available from the Function Bar (F12), the Action Menu, and the Main tool bar icon.

If you are working on a New Job or modifying an existing job (i.e.  not  just  viewing),  you won't  be able to
clear the form because you need to Action the current job first (Action... Book-In/Book-Out/Delete etc.)
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To Clear the Main Form

· First of all, lets retrieve a Job Document onto the Main Form so in the Tool Bar, click the View Last
Document icon

 
· After viewing a Job Document click the Clear Form Icon on the main Tool Bar.

Sometimes you cant just Clear the Form. We'll explain this now. First of all retrieve the last Job
Document onto the Main Form again.
 
· Now with a Job Document on the Main Form being viewed, from the Action menu choose Modify

· Now click Modify Job to confirm
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Note the Job State has now changed from just 'Booked In', to 'Modify Job Booked In'. This Job-Document
for dental surgeon Mr B Adams, can now be edited. 

We'll assume that for some reason we want to mark this job such that when it is booked out, an Invoice
will not be raised. In other words, the job won't be charged for at this stage but it will be stored in a state
of 'Booked Out Ongoing'.

· Click in the On Bookout box and Change it from 'Charge' to 'On-Going'

· Now choose Action - Clear Form

  ...Having trouble ?
 
The Clear Form action is disabled\greyed out and Transactor will not let you clear the Form because you
may accidentally lose job details. Instead, if you want a clear form you first need to decide what you
want to do with this Job Document that is currently being modified. We could Book it back in, Book it
out, put it On Hold, or Delete it. Let's just do the most likely thing if we were modifying a Booked In job,
we'll Book it out.

· Choose Action - Book Out (F8)
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Notice Transactor 'knows' this job is to be booked out without charging at this stage, so you are asked
to confirm Book Out Job Ongoing. Now you will see a clear form. If you choose View Last document
you'll see that the state of this job is marked as Job Booked Out Ongoing.

Now let's move on to Tour Surgeons

4 Tour Surgeons

Ok so far but now it's time to get to take a peek at selecting Surgeons and Practices onto the Main
Form.

· If you already have a job on the form, choose Clear Form first.

Note: If the Clear Form function is disabled (greyed out) and you are unsure what to do, see 
Understanding Actions

Selecting a Surgeon for a job 

 
· From the Surgeon menu, choose Select..

9
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· In the Surgeon Account Selector’s list, choose 'Beresford'. There are three easy ways to do this. (i) By
double clicking the row with the mouse, or (ii) Hi highlight the row and press Enter. or (iii) Highlight the
row and click Select.

That  Surgeon  has  now been  selected  onto  the  Main  Form.  In  the  example  lab,  Mr  Beresford's
practice address is the same as his invoice address and so Transactor has no need to display  it  in
full. 

In case you are wondering, Surgeons can have several accounts,  each one working out  of different
practices. You'll see how this works in the User Guide.

We chose Mr Beresford  (account  no 274) as  the Surgeon in our example because  that’s  one  of
the four surgeon accounts that has sample jobs. The others are 'Adams', 'Dodds' and 'Kelly'.

If  you  know a  Surgeons's  account  no  you  can  use  it  to  quickly  select  the  surgeon  even  more
quickly. Let's try this but first remember to clear the form (F12).
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· In  the Surgeon Account box,  type 274 and press Enter.

Mr Beresford's details are retrieved onto the Main Form. 

Another way select a Surgeon onto a clear form is by surname. Don't forget to clear the Main Form first.

· In  the Surgeon Account box,  type the surgeon's surname (or just the first few letters of it) and press
Enter.

A window will appear showing any Surgeons matching what you typed. If only one account is showing
you can just press Enter to save time, otherwise highlight the correct account and then choose 'Select'.

In this topic we've shown you a few ways to retrieve a Surgeon's details onto the Main Form. You may
want to do this either to view the Surgeon's record, job list/history, or to assign the Surgeon to a New
Job. 

5 Understanding Surgeons and Practices

Let's spend a moment to understand how Transactor assigns and maintains Surgeons with Dental
Practices.

In Tour Surgeons  you saw how Surgeon Accounts are selected onto the Main Form for various day to
day tasks such as booking in a job. The Main Form Surgeon menu can also be used to Add and Modify
Surgeon accounts.

Let's now take a peek at the Surgeon Accounts page in the Setup Wizard because it's a good way to
show you graphically, how Surgeon's can work out of one or more Dental Practices.

9



Transactor Coffee Break Tour12

©2009 Pearce and Robinson LTD

To view the Surgeon Accounts page in the Setup Wizard

· From the Tools menu, choose Setup Wizard
· In the Setup Wizard, choose Next until you get to the Surgeon Accounts page
· Click on Battle Dental Surgery

A list of Surgeons will appear in the bottom window who work out of the selected Dental Practice.

Take a mental note that Mr J Blunt has a Surgeon Account assigned to this Practice. Suppose Mr Blunt
has just phoned to say he will now work out of Bohemia Dental Surgery as well as Battle Dental
Surgery.

· In the upper window, select 'Bohemia Dental Practice', note there are already three Surgeons with
accounts at this Practice.

· Click Add New
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· In the 'Add New Surgeon Account' form, enter Mr Blunt's name and initials and click Ok

So now Mr Blunt now has two accounts, one of which is his new account for work sent to Bohemia
Dental Practice, and the other for work sent to Battle Dental Practice.



Transactor Coffee Break Tour14

©2009 Pearce and Robinson LTD

Now click  on Back  to go to the Dental Practices  page.  That  is  where you can experiment  with  adding
new Dental Practices, or changing their details.

· Click Finish to exit the Setup Wizard

You will find yourself back at the clear Main Form. If you choose Surgeon - Select from the Main Menu,
you'll see that Mr Blunt's name appears twice, once at each of the two practices he works out of.

6 Jobs and Documents

In this topic we'll take a look at the various ways of handling jobs and documents on the screen. 

One common requirement is to view a list of jobs for a selected Surgeon. 

Using the Surgeon History

· Select Dodds (204) onto the Main Form  (see Tour Surgeons )
· From the Surgeon menu, choose  History (F11)..

You’ll  see a list  of jobs ‘Booked  In’  and  jobs  ‘Booked  Out  Charged’  for  'Dodds'  .  You'll  also  see  his
payments.

· Highlight the job for the patient 'Parrish,M' (DocNo 1381) and click ‘View’.
· If you scroll  up you'll  see the items at  the top of Mr Dodd's  list  are  in  black.  This  means  they  are

'locked'  and  cannot  be  modified.  The  Main  Help  explains  about  Locking  and  Un-Locking  of  Job

9
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Documents.

You’ll see a summary view of the selected job in a window.  We'll  go the whole hog and select  this  job
onto the main form.

· In the Document window, choose Select Onto Form  

Now we have a job shown on the Main Form. It  is  in a ‘Read’ or ‘Viewing’ state with  grayed-out  text,
this indicates you can’t accidentally modify any details. Look at  the Function Bar to get  a hint  of what
you can now do with this job/document. 

In fact there are several ways to quickly retrieve job details onto a clear Main Form.



Transactor Coffee Break Tour16

©2009 Pearce and Robinson LTD

Surgeon History (which we have just used)
or Job Number
or View \ Booked In Jobs due by
Tools \ Patient Search  (You can type all or the first part of the patient’s name and press Enter). 
View \ Jobs-Documents (Scroll down to the selected Job).

Try each of these now. Clear the Main Form each time.

7 Booking In a New Job

You’ll need a clear Main Form so if there’s a job showing, you need to clear it first.

Starting a New Job 

 

· From the Action Menu, choose 'New Job', (or press F3).

Notice the new Document No (The Job No) is visible on the right). This Example Lab is set up to do to
automatic job numbering but in your 'Live' system you can use the Setup Wizard to opt for manual job
numbering so that you enter the new job numbers yourself if you wish.

· Select a Surgeon onto the Main Form. If not sure how to, see Tour Surgeons

For the moment we'll skip Usual Prices, On Bookout and Due Date info as these are explained in the
main Help. 

· Enter a Patient name by double-clicking 'Patient' in the 'Code' column. 

9
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Now we'll move on and enter some Product/Services.

· Place the cursor on a blank row in the Code column and press Enter, or choose Products & services
from the Product/Service menu.

· Highlight an item such as 'BCP' and choose Select onto form... 

· Verify or amend the price and quantity, then click OK.

· On another  blank  row,  press  Enter,  and  the  Products  and  Services  window will  appear.  You  can
change the properties of one of the line items.

o Right click the item and choose Properties

or
o highlight the item and click the Options button

In the Properties window you can change the price, description, or other properties. 

Close the Properties window if you have opened it.

· Choose Select onto form

Repeat the above steps a few times to add a few more Products or Services.
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After you have specified the details of the job, we can proceed to Book it in.

· From the Action Menu choose Book In (F7) and click OK
· The Confirm Action window appears. Here you can choose to print a job ticket if you wish, or just

leave the output box blank.
· Click Ok

That's it, the job is booked into Transactor, but It can be retrieved at any time.

Notes

The full User Guide has a lot more information for example:  

How you can use the keyboard instead of the mouse.
Using automatic  job numbers  or  manually  typing  in  your  own  unique  job  number  each  time  you
start a new job.
Why in this example the Independent price band came up automatically  for this  Surgeon,  and how
a Surgeon's preferred price band can be configured.

Notice that this Job could be directly Booked In and Out straightaway by choosing Action-New Job
then  Book-Out.  You'd  only  want  to  do  this  if  the  work  had  commenced  without  the  job  being
booked into the computer (not a recommended practice).

Transactor didn't   print  anything when you booked the example job in,  but  the User Guide  shows
you how Transactor can be configured to prompt you for your usual printing habits,  a Job Ticket  on
Booking In, Despatch Notes and Invoices on Booking Out. Isn't Transactor wonderful!

8 Booking Out a Job

After having tried some Booking In let's have a quick go at at Booking Out. 

NOTE
For more details and options refer to Booking Out a Job - (main Help).

To Book Out a Job (Summary)

· Retrieve the Job onto the Main Form
· Edit/Modify  the Job if the details  need updating or the On-Bookout  box is  not  correctly  set  (to  either

'On-Going' or 'Charge').
· Choose the Book Out action

To Book Out a Job (step by step)
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First ensure you have a Clear Form .

There are several ways to quickly locate and retrieve a Job on the computer.  The fastest  is  by  using the
Doc No,  also called a Job No.  We will  assume we don't  have the job  number  handy  and  select  a  Job
from Mr Beresford's history list.

· Select  Mr  Beresford  onto  the  Main  Form.  If  you  don't  know  how  to,  see  Tour  Surgeons ,  then
choose Surgeon History.

· In the Surgeon Account  History  window, highlight  one of the jobs at  the bottom with a description  of
'Job Booked In'.

· In the Surgeon Account  History  window, highlight  one of the jobs at  the bottom with a description  of
'Job Booked In'.

· Click View, then in the next window press Enter to choose the Select Onto Form button.

· From the Action Menu, choose Modify or press F4

6
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· Ensure the On-Bookout box is set to Charge. (in this example we want to finalise the job when it is
Booked Out this time).

· From the Action menu, choose Book Out or press F8

· In the Confirm Action window, ensure Output is set to Delivery Note to Practice (A4),  to Batch Queue,
then Press Enter.

That's it, this job is Booked Out and finalised. It will appear on this Surgeon's statement for this month. 

After a batch of  jobs  have  been  booked  in  we  can  optionally  print  despatch  notes  with  Jobs  grouped
together by Dental Practice. See Printing a daily report

Note

21
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If  required,  we  could  have  setup  Transactor  to  automatically  print  an  Invoice  as  well  as  the  batched
Despatch  Note,  but  there's  more  about  this  in  the  main  Help.  You  may  be  interested  to  know  what
happens if you notice a mistake after booking a job out.  Well normally  you can still  modify  the job and
book it back out again providing the lab manager hasn't  done a 'Locking' for the finalised (charged) jobs
in this date period. Again there's more about this in the main Help.

See also
Selecting an Existing Job - (main Help)
Patient Search - (main Help)

9 Printing a daily report

Printing a Booked In Jobs Report 

A typical daily report which is used for Job Scheduling.

· From the Reports menu, choose  Jobs - Booked in jobs (by Due Date)
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· You’ll get a few options but you can leave these as they are and just click OK.
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The report will come up in a print preview window.

· To print a hard copy of the report, click the Printer icon on the Tool Bar.

Note: The above report is useful since it is effectively a Job Schedule showing booked in jobs by due
date, the most urgent at the top. Some larger labs use this report on a daily basis, choosing the other
flavor of this report specifying the due date in the report options.

Printing Despatch Notes to Practice

After a session of booking out jobs, we may want to print off the Despatch notes grouped by Dental
Practice.

· From the Tools menu, choose Print Manager
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Notice the View group box is set to Un-Printed Batches by default.

· Click Select All, then Print then Ok to see the Despatch notes in a Preview window (we won't print
them to a physical printer now).
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Notes
This report is very useful because the delivery driver will get one despatch note per Dental Practice even
if several Surgeons are at that Practice. Also notice the Checked by and Received by signature areas.

If you prefer to keep Delivery Notes per job, or per Surgeon then then you can do this too. See the main
Help.

10 Statements

In this  topic  we will  preview (but  not  print  out)  Statements  for  All  Surgeons  for  the  example  DentaLab
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Limited.

Printing surgeon statements

· From the Reports menu, choose Surgeons - Statement (monthly)

You’ll get a few options but you can leave these as they are. 

Notice in this example, that the Surgeon A/c no. box is blank; this means we'll get a Statement for all
Surgeons. 

If the Surgeon A/c no box is not blank, this is because there was a Surgeon showing on the Main Form
when the Report menu was chosen; simply clear the 'Surgeon a/c no.' box.

· Confirm that the 'Output To' setting is 'Preview Window' then choose OK. Individual statements for all
surgeons will be produced.
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· Click on the Next Page icon to step thru the Statements.

If we wanted to print these statements (from the Printer Icon shown above), we could either print all
statements or specify the page number range.

· Close the Preview Window.

To produce a statement for an individual surgeon, either select a surgeon onto the Main Form before
choosing the Report, or in the Report Options, type in the a/c number before clicking OK.

Try also… 

Running some of the other reports. As long as you leave the ‘Output to’ box as it is, all reports will
go to a preview window so you won’t need to waste paper. 

Try the Surgeon Summary Invoice report which summarises invoices for an individual surgeon
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account and month with a grand total amount. Some labs use this instead of printing individual
Invoices. 

Try re-running the Statements but this time choose the Surgeon Statement (date Range). This
means that the aged analysis at the bottom of the statement is 30/60/90 days rather than current
month/1mth/2mth/3mth. You will see which type is more suitable for the way you deal with your
surgeons.

11 What Next

That completes the Coffee Break Tour tutorial.

We recommend you now go to Start your live Transactor and Set up Transactor for your lab in the main
help.

We hope you have enjoyed your experience with Transactor so far.

Please contact us if you have any questions.

Website Contact Us: www.transactor.co.uk
Sales & Support Line:  01424 777877

Pearce & Robinson LTD
17 High Street, Battle, Sussex TN33 0AE
Tel: 01424 777877
www.transactor.co.uk
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